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1.0 Introduction

The Ludlum Dimension Configuration Manager software is a software package
that calibrates any of the Dimension product line of instruments. Calibration
and configuration of the Dimension product line requires a special USB cable
for communication between the Dimension Configuration Manager software
and the instrument. This manual covers the installation and configuration of the
Dimension Configuration Manager software.
See Section 4.0 Dimension Configuration Manager Software Installation for
installation instructions.
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2.0 Software License
Agreement

BY INSTALLING THIS SOFTWARE, YOU ARE CONSENTING TO BE
BOUND BY THIS AGREEMENT. IF YOU DO NOT AGREE TO ALL OF THE
TERMS OF THIS AGREEMENT, DO NOT INSTALL THE PRODUCT.
Single User License Grant: Ludlum Measurements, Inc. ("Ludlum") and its
suppliers grant to Customer ("Customer") a nonexclusive and nontransferable
license to use the Ludlum software ("Software") in object code form solely on a
single central processing unit owned or leased by Customer or otherwise
embedded in equipment provided by Ludlum.
Customer may make one (1) archival copy of the Software provided Customer
affixes to such copy all copyright, confidentiality, and proprietary notices that
appear on the original.
EXCEPT AS EXPRESSLY AUTHORIZED ABOVE, CUSTOMER SHALL NOT:
COPY, IN WHOLE OR IN PART, SOFTWARE OR DOCUMENTATION;
MODIFY THE SOFTWARE; REVERSE COMPILE OR REVERSE ASSEMBLE
ALL OR ANY
PORTION OF THE SOFTWARE; OR RENT, LEASE,
DISTRIBUTE, SELL, OR
CREATE DERIVATIVE WORKS OF THE
SOFTWARE.
Customer agrees that aspects of the licensed materials, including the specific
design and structure of individual programs, constitute trade secrets and/or
copyrighted material of Ludlum. Customer agrees not to disclose, provide, or
otherwise make available such trade secrets or copyrighted material in any form
to any third party without the prior written consent of Ludlum. Customer agrees
to implement reasonable security measures to protect such trade secrets and
copyrighted material. Title to Software and documentation shall remain solely
with Ludlum.
LIMITED WARRANTY. Ludlum warrants that for a period of ninety (90) days
from the date of shipment from Ludlum: (i) the media on which the Software is
furnished will be free of defects in materials and workmanship under normal
use; and (ii) the Software substantially conforms to its published specifications.
Except for the foregoing, the Software is provided AS IS. This limited warranty
extends only to Customer as the original licensee. Customer's exclusive remedy
and the entire liability of Ludlum and its suppliers under this limited warranty will
be, at Ludlum or its service center's option, repair, replacement, or refund of the
Software if reported (or, upon request, returned) to the party supplying the
Software to Customer. In no event does Ludlum warrant that the Software is
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error free or that Customer will be able to operate the Software without
problems or interruptions.
This warranty does not apply if the software (a) has been altered, except by
Ludlum, (b) has not been installed, operated, repaired, or maintained in
accordance with instructions supplied by Ludlum, (c) has been subjected to
abnormal physical or electrical stress, misuse, negligence, or accident, or (d) is
used in ultra hazardous activities.
DISCLAIMER. EXCEPT AS SPECIFIED IN THIS WARRANTY, ALL EXPRESS
OR IMPLIED CONDITIONS, REPRESENTATIONS, AND WARRANTIES
INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTY OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE,
NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING,
USAGE, OR TRADE PRACTICE, ARE HEREBY EXCLUDED TO THE
EXTENT ALLOWED BY APPLICABLE LAW. IN NO EVENT WILL LUDLUM
OR ITS SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT, OR
DATA, OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTAL, OR
PUNITIVE DAMAGES HOWEVER CAUSED AND REGARDLESS OF THE
THEORY OF LIABILITY ARISING OUT OF THE USE OF OR INABILITY TO
USE THE SOFTWARE EVEN IF LUDLUM OR ITS SUPPLIERS HAVE BEEN
ADVISED OF THE POSSIBILITY OF SUCH.
DAMAGES. In no event shall Ludlum's or its suppliers' liability to Customer,
whether in contract, tort (including negligence), or otherwise, exceed the price
paid by Customer. The foregoing limitations shall apply even if the above-stated
warranty fails of its essential purpose. SOME STATES DO NOT ALLOW
LIMITATION OR EXCLUSION OF LIABILITY FOR CONSEQUENTIAL OR
INCIDENTAL DAMAGES.
The above warranty DOES NOT apply to any beta software, any software made
available for testing or demonstration purposes, any temporary software
modules or any software for which Ludlum does not receive a license fee. All
such software products are provided AS IS without any warranty whatsoever.
This License is effective until terminated. Customer may terminate this License
at any time by destroying all copies of Software including any documentation.
This License will terminate immediately without notice from Ludlum if Customer
fails to comply with any provision of this License. Upon termination, Customer
must destroy all copies of Software.
Software, including technical data, is subject to U.S. export control laws,
including the U.S. Export Administration Act and its associated regulations, and
may be subject to export or import regulations in other countries. Customer
agrees to comply strictly with all such regulations and acknowledges that it has
the responsibility to obtain licenses to export, re-export, or import Software.
This License shall be governed by and construed in accordance with the laws of
the State of Texas, United States of America, as if performed wholly within the
state and without giving effect to the principles of conflict of law. If any portion
hereof is found to be void or unenforceable, the remaining provisions of this
License shall remain in full force and effect. This License constitutes the entire
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License between the parties with respect to the use of the Software.
Restricted Rights - Ludlum's software is provided to non-DOD agencies with
RESTRICTED RIGHTS and its supporting documentation is provided with LIMITED
RIGHTS. Use, duplication, or disclosure by the Government is subject to the
restrictions as set forth in subparagraph "C" of the Commercial Computer Software Restricted Rights clause at FAR 52.227-19. In the event the sale is to a DOD
agency, the government's rights in software, supporting documentation, and
technical data are governed by the restrictions in the Technical Data Commercial
Items clause at DFARS 252.227-7015 and DFARS 227.7202. Manufacturer is
Ludlum Measurements, Inc. 501 Oak Street Sweetwater, Texas 79556.
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3.0 Getting Started

The Dimension Configuration Manager software can run on both desktop and
server operating systems and also can be installed on a virtual machine. It is
necessary for all components to be installed on a single computer.
3.1 Software Prerequisites
The following software must be installed on the network and working before
installing the Dimension Configuration Manager software. Any software
prerequisites that are from Microsoft can be downloaded at
http://www.microsoft.com/download/.
Windows Installer 3.1 or later. Windows Installer is not included on the
installation media.
Internet Explorer 5.01 or later. Internet Explorer is not included on the
installation media.
.NET Framework 4 Client Profile or later. .NET Framework 4 Client
Profile is included on the installation media.
FTDI Virtual COM Port Driver version 2.08.14 or later. FTDI Virtual
COM Port Driver is included on the installation media and can be
downloaded automatically from Windows Update (with an available
Internet connection) or manually downloaded from FTDI’s web site
http://www.ftdichip.com/Drivers/VCP.htm.
The
installation
documentation for the supported versions of Windows are included in
the Documentation directory on the installation CD.
See the appropriate installation documentation for the above items.
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3.2 Minimum Requirements
Supported Operating Systems: Windows 7, Windows 7 Service Pack
1, Windows Server 2003 Service Pack 2, Windows Server 2008,
Windows Server 2008 R2, Windows Server 2008 R2 SP1, Windows
Vista Service Pack 1, Windows XP Service Pack 3
Recommended Minimum: Pentium 1 GHz or higher with 512 MB
RAM or more (1 GB or more is recommended)
2.5 GB of free hard disk space
3.3 Installation Overview
The installation requires all of the components to be installed on a single
computer or virtual machine. The steps are:
1. Install any required prerequisites.
2. Install the Dimension Configuration Manager software.
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4.0 Dimension Configuration
Manager Software Installation

4.1 Installing the Dimension Configuration Manager
software
To install, run LMIDimCfgMgr.MSI (which can be found on the installation
media) and follow the on-screen prompts.
The installation program requires administrator privileges. Some versions of
Windows, usually Professional and above, will prompt you to allow the
installation program to make changes on this computer:

Figure 1 - User Account Control window on Windows 7 Professional

Click on the Yes button to continue the installation.
You will be prompted to accept the End User License Agreement. Should you
choose not to accept the agreement, the installation will exit without installing
the application.
Next, you will be given the choice of which type of installation you want to
perform. For most situations, the typical installation type will be sufficient. If you
wish to modify which components are installed, choose the custom installation
type.
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If you choose the custom installation, you will be prompted for which
components you want to install and a folder to install the application.
The default installation location is:
System Type
Location
32 bit Windows
C:\Program Files\Ludlum Measurements, Inc\DCM
64 bit Windows

C:\Program Files (x86)\Ludlum Measurements, Inc\DCM

You are ready to install the application.
When the application installation completes successfully, a window with the
latest information about the application will be displayed.
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5.0 Dimension Configuration
Manager Software Configuration

5.1 Configuring the Dimension Configuration Manager
The Dimension Configuration Manager software currently has two settings that
can be configured:
Theme
Logging
Configuration…
5.1.1 Configuring Themes

You can configure the color theme used by the Dimension Configuration
Manager software by choosing from the menu Options → Theme → theme color.

Figure 2 - Selecting the color theme

Figure 3 - Example of the blue theme in use
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5.1.2 Configuring Logging

You can configure the level of logging to be performed by the Dimension
Configuration Manager software by choosing from the menu Options →
Logging → logging level.

Figure 4 - Selecting the logging level

The Dimension Configuration Manager software currently has three logging
levels:
Level
Debug

Information

Minimum

Ludlum Measurements, Inc.

Description
Performs the most detailed logging of the application events
and communications. This level of logging includes all of
the logging level(s) listed below. This is the recommended
logging level to use when there are communication issues
with the instrument. This setting will generate a significant
number of log entries that, over time, will cause the log files
to become very large. Note: This is the recommended
setting for most users.
Performs a lesser detailed logging of the application events
and communications. This level of logging includes all of
the logging level(s) listed below. This is the recommended
logging level to use when there are no communication issues
with the instrument.
Performs the bare minimum logging of the application
events and communications that are always recorded (e.g.,
application start-up). This logging level is recommended to
use when there are no communication issues, and the user
has sufficient experience with the application to determine
when to switch to a more detailed logging level.
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5.1.3 Configuration Information

You can configure the information displayed on the reports. Two fields are
provided on the Configure Information window. Company Name is the name
of the company that will be displayed on all reports. Company Information is
any supplemental information (i.e., Address, Phone, Fax, web site, etc.) that will
be displayed on all reports.

Figure 5 - Configure Information window
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5.1.4 Command Line Options

You can configure the Dimension Configuration Manager software by using
command line options. Each command line option must start with a forward
slash (/) and be separated by a space.
Option
/c:COMx

Description
Specify a serial communications port preference. The
Dimension Configuration Manager will scan this port first
looking for an instrument. If no instrument is found
connected to this port, the DCM will scan all of the serial
communications ports available on the system as if this
command line option had not been specified. Section 6.1.1.2
Instrument Menu contains more information.
Example: C:\Program Files (x86)\Ludlum Measurements,
Inc\DCM\Dimension Configuration Manager.exe
/c:COM5
In this example, if an instrument is physically connected to
serial communications port 5, and turned on, the DCM will
attempt to connect to the instrument first using COM5. If
the instrument is unavailable, then the DCM will scan all
available serial communications ports for an attached
instrument.
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6.0 Quick Tour

6.1 Main Window
The main window has several sections of note:
Menus
Tab selection buttons
Tab pages
Status bar
Action buttons

Figure 6 - Main window
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6.1.1 Menus
6.1.1.1 FILE MENU

Figure 7 - File menu

Open Command File

Figure 8 - File menu → Load Default Configuration From File → available instrument models

Command files (referred to as configuration files) are used to make
configuration changes to an instrument. These files can be installed on a USB
thumbdrive and plugged into an instrument anytime it is powered on to make
configuration changes. This menu option allows the user to use the Dimension
Configuration Manager to send these configuration files without the use of a
USB thumbdrive.
Load Default Configuration From File → available instrument models

Figure 9 - File menu → Load Default Configuration From File → available instrument models

Pick a model from the menu, and the application loads a factory default
configuration. No instrument or cable is required to be connected for this to
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function. You will not be able to perform any updates or real time readings
using this method to load a configuration.
Update Instrument
Communicate changes to the instrument. This menu item is equivalent to the
Update Instrument button on the Tab Selection buttons.
Reports → available reports

Figure 10 - Reports → available reports

The application currently has two reports that can be generated from a
connected instrument: As Found; and Calibration. You will receive a warning if
you attempt to print a report without a connected instrument.
Exit
Disconnects from the instrument and shuts down the application.
6.1.1.2 INSTRUMENT MENU

Figure 11 - Instrument menu

Scan For Instrument
Perform a scan of all available serial ports (RS-232 and virtual) for an instrument.
Results of the scan will be displayed in the status bar. If an instrument is found,
the port name will be displayed next to the connection status indicator.
Otherwise, it will display “N/A”.
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Load Configuration
Connect to the instrument. Some instruments will change the display to indicate
a connected state. The connection status indicator will change to green. The
application will query the instrument for its current settings, displaying them on
various tab pages.

Figure 12 - Connection status showing connected

Disconnect From Instrument
Disconnect from the instrument. This will also stop the real time readings (if
currently started). Some instruments will change the display to indicate a
disconnected state. The connection status indicator will change to red.

Figure 13 - Connection status showing disconnected

Real Time Readings

Figure 14 - Instrument menu

Turn on or off the real time readings being sent from the instrument. Real time
readings are displayed on any scale/meter face being displayed. This menu item
is disabled until a connection to an instrument is made.
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Backup
Perform a backup of the instrument’s settings. Upon completion of the backup,
the instrument will reboot. This menu item is disabled until a connection to an
instrument is made.
Restore
Disconnects from the instrument and shuts down the application. Upon
completion of the restore, the instrument will reboot. This menu item is
disabled until a connection to an instrument is made.
6.1.1.3 OPTIONS MENU

Figure 15 - Options menu

This menu and its options are covered in Section 5.1 Configuring the
Dimension Configuration Manager.
6.1.1.4 HELP MENU

Figure 16 - Help menu

Check for updates
Check for application and configuration updates through the Internet.
View Log File
View the log file contents.
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About
Open a window that shows version information about the application and
configuration files.
6.1.2 Tab Selection Buttons

Figure 17 - Tab Selection buttons

Click on one of the tab selection buttons to make that set of tabs visible. With
this version of the application, only the Instrument, Settings, Controls,
Functions, and View tabs are available. The Instrument tab selection will
contain fields relating to the instrument board settings. The Settings tab
selection will contain fields relating to the instrument’s primary configuration
settings. The Controls tab selection will contain fields relating to the audio and
lighting of the instrument. The Functions tab selection will contain fields
relating to the configuration of system-wide function availability. The View tab
selection will contain a Control tab page and individual view configuration tab
pages.
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6.1.3 Tab Pages

Figure 18 - Tab Pages

Each of the tab pages contains fields for different configuration items on the
instrument. Each instrument model (9DP, 9DP-1, 9DLP, 3D, 3D+, etc.) will
have different controls displayed on each of the tabs. While some of the tabs
may contain exactly the same fields between models, this should not be
expected.
Checkout
This tab page will contain fields that are used to configure the instrument’s main
board settings. This is primarily for the voltage and battery settings.
Calibration
This tab page will contain fields that are used to configure the instrument’s
detector calibration settings. This is primarily for the calibration constants
settings. The real-time readings display is usually on this tab page.
Field Readings
This tab page will contain fields that are used to display field strengths and
readings only on reports. Values entered into the fields on this tab are not
stored on the instrument or anywhere else.
6.1.4 Status Bar

Figure 19 - Status bar

The status bar is divided into three sections. The left side is the status message
area. On the right side are the serial communications port name and the
connection status icon.
Performing various actions within the application will change the status message.
Some actions will also display a pop-up window with detailed information.
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6.1.5 Action Buttons

Figure 20 - Action buttons

The three action buttons are (from left to right): Load Configuration From The
Instrument; Disconnect From The Instrument; and Update The Instrument.
The Load Configuration From The Instrument action button is enabled when
an instrument has been located on an available serial communications port.
Refer to Section 7.2 Loading An Instrument Configuration for more
information about the connected state. The Disconnect From The Instrument
action button is enabled once a connection has been made with an instrument
and disabled when the connection has been closed. Refer to Section 6.1.1.2
Instrument Menu for more information about the connected state. The Update
The Instrument action button is enabled when a change has been made to a
field that has not been sent to the instrument. Refer to Section 7.4 Updating The
Instrument for more information about updating the instrument.

Figure 21 - Action buttons when an instrument is connected and a field is ready to update to the instrument
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7.0 Operation

The Dimension Configuration Manager software performs a specific function
utilizing generic methodologies. Application operations are discussed from a
generic instrument standpoint. Instrument specific operations (checkout and
calibration) are documented separately.
7.1 Start-Up
When the application starts, many functions are performed automatically for
you. At the start of the application, the application will scan for the instrument.
If the instrument is connected and powered up, the application will display the
serial communications port name in the right section of the status bar. If your
computer is connected to the Internet, the application will also check for any
updates.
7.2 Loading An Instrument Configuration
If a serial communications port name is displayed in the right section of the
status bar, you can load an instrument configuration by choosing Instrument →
Load Configuration from the menus or by pressing the F5 key on your
keyboard. The application will set the instrument into a connected state. On
some instruments, this will change the instrument display. Fields will be loaded
onto the tab pages with the current settings from the instrument. Please refer to
the instrument specific documentation for checkout and calibration for a list of
fields, acceptable values, and definitions that will be on each tab page.
Note: If the instrument model loads a current date and/or time, the date/time
field will be at the time the application requested the information from the
instrument. Current date/time fields do not update as time progresses.
When the application is in a connected state with the instrument, the connection
status indicator will change to green. While the connection status indicator is
green, you should not physically disconnect the instrument from the computer
without first instructing the application to disconnect from the instrument.
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7.3 Changing A Field Value

Figure 22 - A blank text field value

Changing the value of a field is dependent on the type of field being displayed.
Text fields can display any type of text available. While the field entry is not
restricted to a specific type of text (e.g., numbers), the purpose of the field may
require that the field be numeric.

Figure 23 - A text field that has been changed

Figure 24 - Update Instrument button and menu item available

Once a field value has been changed from the value loaded from the instrument,
the background color of the field will change colors (to a theme-based color).
The Update Instrument menu item and button in the action buttons will
become available. Click on either the Update Instrument button or menu item
to save the changes to the instrument.

Ludlum Measurements, Inc.

Page 22

March 2020

LMI Dimension Configuration Manager

Software Manual

Figure 25 – Pop-up menu for a field

You can revert an individual field’s value back to the current value on the
instrument. To revert, opposite-button-click on that field. Click Revert on the
pop-up menu that appears to change the value to the current value from the
instrument. Menu items will vary with the field type and what actions have been
performed.

Figure 26 - Using the computer's date and time to set the instrument’s value

Date and time fields have a check mark that instructs the application to use the
computer’s date or time when setting the instrument’s values. Tick the check
mark to use the computer’s date or time. Untick the check mark to manually set
the date or time.
7.4 Updating The Instrument
Click on the Update Instrument menu item, or button in the tab selection
buttons, to send the changes to the instrument. After the instrument has been
updated successfully, the field will change the background color to its default
color. The Update Instrument menu item and button will become disabled
(grayed out).
If a field does not update successfully, a window will be shown listing all of the
fields that did not update. The most common cause of a field not updating is
trying to change a read-only field.
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Figure 27 - Fields that did not update

7.5 Real Time Readings

Figure 28 - Real time readings meter face

Real time readings from the instrument can be started only when an instrument
is in a connected state with the application. Refer to Section 6.1.1.2 Instrument
Menu for more information about the connected state. The real time readings
meter face will display the same information as your instrument. If your
instrument is set to automatically change ranges, the meter face will mimic the
changes as they occur.
Important: Failing to disconnect from the instrument can cause real time
readings from the instrument to have communication issues with the
application.
Note: The real time readings meter face will change with the instrument model
that is being connected.
7.6 Disconnecting The Instrument
You can disconnect from the instrument by using the Instrument menu (see
6.1.1.2 Instrument Menu) or by shutting down the application through normal
means (e.g., clicking the red “X” at the top of the window). This step is required
before returning the instrument to a service status.
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Important: Failing to disconnect from the instrument can cause real time
readings from the instrument to have communication issues with the
application.
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8.0 Troubleshooting

8.1 Instrument Not Found At Application Start-Up
There are several possible reasons that an instrument cannot be found when
starting the application:
Reason

Solution

Cable is loose or
missing

Reconnect the cable at both ends. Scan for the instrument
again. If the application is being run on a virtual machine,
configure the virtual machine to have access to the cable.

Cable is not the
supplied cable

The Dimension product line requires a special USB cable
for communications between the Dimension Configuration
Manager and the instrument. An off-the-shelf USB cable
will not communicate correctly with the instrument. Find
the special cable supplied with the software. If your cable is
lost or damaged, you can order another cable (LMI part
number 21-8758) directly from LMI or your local
distributor.

Instrument not
powered up

Turn the instrument on. Scan for the instrument again.

Interference with
another serial device

Disconnect the other serial device’s cable (if external).
Disable the device within Windows using the Device
Manager.

8.2 Tab Pages Display Unusual Instrument Information
This can happen when an instrument was in the real time readings mode and
not disconnected from the application. To correct this, power down the
instrument for a moment and then power it back up. Ensure the cable is
properly connected. Load the instrument configuration again.
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